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1. szuUaNDINANIA7

1.1 dupenaclenlfoazls

52UUEleR2 %30 duaeInarena (embedded system) AnszuuUssutana Nltdunsolulas
Inswawesfioanuuuulagianiy Wuszuuasuiawesvuinidanilslilugunsal w3esldlnin
LaziAtauBlannsetindsiiae) atiiuaiiuaain Auawnsabitugunsalivatuniy

U o 1

FONALISTIA1991NTLUVUTZUIANANLATDIADNNUMDINLU Seuvuiladtnnirunldiuseng

U
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1.2 A32UIUNTTLVITZUY (Input — Process — Output)

INPUT ’ PROC ESS} OUTPUT

LED Display

&

==

Input

1. @sndownly (Input )
e demnes A9ndudedddlunsyuiunisnielasinsnieg 1y
TuszvunisiSeunisasuluduisey 91alawn A3 UnSeU FuSeU Yanans

3 Raeu Isnmsaeu Wusu diludesssuumels 01aldun aun Jen nszdsau
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2. NSTUIUNTUIDNTANTUINU ( Process)

%

wneds Madnedsiideudili indnnsgilifanaussganuingussasrnaednis

U MIFRUYDIA IBNITtnSeiAansew WWudy

3. nandn nIon15UsTIUNE (Output)
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2. Internet of Things (loT)

Internet of Things(loT)

101 - The Beginner

REAL
@1.1.
UIEN 13ealan ne iet.i rat
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Agenda

Apply

Workshop

Impact

What is loT

REAL . .
@1.1. | roiet.io

What is Internet of Things

——————————

Source: OpenSAP

Internet of Things (loT) or Internet of Everything (IoE) refers to devices or objects that are connected to the Internet, like your smartwatch,
lamp, or even your refrigerator. These devices are able to collect and transmit data via the Internet, contributing to our big data world.

REAL . .
@11. | roiet.io

[

edD_
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Evolution of loT

Pre- Internet of
internet PEOPLE
“HUMAN “SOCIAL “MACHINE
TO “Www” “WEB 2.0” MEDIA” TO
HUMAN" MACHINE”
*Fixed & *e-mail * e-productivity *Skype «ldentification, tracking,
mobile *Information *g-commerce *Facebook monitoring, metering, ...
P «Entertainment . *YouTube *Automation, actuation,
*SMS payment, ...

REAL . .
@1.1. | roiet.io

Trend

- ons Internet of Things
4 Natural-Language Question Answering
sosci e T A
lonomous Vehicles
Cryptocurrencies
o S Complex-Event Processing
Data Science Big Data
Prescriptive Analytics o L R
Neurobusiness ContentAnahtics
Biochips

Hybrid Cloud Computing
Gamification
Augmented Reality

Affective Computing

SmartRobots Speech Recognition

3D Bioprinting Systems Consumer Telematics
Volumetric and Holographic Displays !:ﬁ";ﬁﬂ:ﬁ.‘"‘“’ 3D Scanners
Software-Defined Anything Services
Quantum Computing . -
Human Augmentation —— Enterprise 3D Printing
Brain-Computer Interface Activity Streams
Connected Home In-Memory Analytics
Gesture Control
Virtual Personal Assistants Virual Rea
ioita] Securily SmantWorkspace lity
Bloacoustic Sensing
As of July 2014
Inncuson —_— Trough of Slope of Enlightenment Plateau of
Trigger Expectations _ Disillusionment P Productivity
time i
Plateau will be reached in: obsolete

Olessthan 2years ©2to5years @5t 10years A morethan 10 years @ before plateau

%EIA'II: roiet.io Source: Gartner

edD_
mdy
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Note: Gartner Hype Cycle

2 Peak of Inflated
Expectations

5 Plateau of
Productivity

Visibility

Slope of
Enlightenment

3 Trough of
Disillusionment

Technology
Trigger

v

Time

%E!A'II: roiet.io Source: thailibrary.in.th

How Big is the loT?

Some analysts estimate the number of connected
devices by 2020.

Gartner — 20 billion
Cisco — 50 billion
Intel — 200 billion

S

World Population: 7.5 Billion (2017)

REAL . -
@17. | roiet.io
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Economic Impact

Nine settings Size in 2025, § trillion’
where value may accrue

B Low estimate High estimate
Factories—eg, operations management, - 1.2-3.7
predictive maintenance -
Cities—eg, public safety and health, traffic - 0.9-1.7
control, resource management
Human —eg, monitoring and managing I 0.2-1.6
iliness, improving wellness
Retail —eg, self-checkout, layout optimization, ._ 0.4-1.2
smart customer-relationship management =2
Outside—eg, logistics routing, autonomous . 0.6-0.9
(self-driving) vehicles, navigation o
Work sites—eg, operations management, I 0.2-0.9
equipment maintenance, health and safety o
Vehicles —eg, condition-based maintenance, I 0.2-07
reduced insurance
Homes —eg, energy management, safety l 0.2-03
and security, chore automation A
Offices—eg, organizational redesign and [ 0.1-0.2
worker monitoring, augmented reality for training e McKinsey believes that the
market for loT could reach
REAL — Total $4 trillion=$11 trillion il
@1y, | roiet.io $11.1 trillion by 2025

IP Address Needs

- |Pv4, handle a maximum 4.3 billion
unique IP addresses

- IPv6, expands from 32 bits (IPv4) to 128 bits

- 96 bits 2 32 bits

L i I IPv4 address :
11192.168.30.1
= :CoA8:1E01

- IPv6, we will have
340,282,366,920,938,463,463,374,607,431,768,211,456
unique IP addresses.

REAL Source: Cisco
GLt. | roiet.io

e®D_
mdy
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Make things connected

e | [
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Make things connected

O
~

REAL - .
@1.1. | rolet.io

Wifi chip

REAL . -
©17. | rolet.io
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Wifi chip

=N -

Hardware:
1. CPU
2. Memory (RAM/ROM)

3. General Purpose I/0O (GPIO)

[gilevndngns 614181009] Page 13]43



ESP8266 Models

ESP-01

ESP-05

ESP-09 ESP-10
REAL . .
@1.1. | roiet.io

ESP8266 Models

Flash = 512KB

Flash = 4MB

ESP-09 ESP-10 ESP-11

REAL - -
@11. | roiet.io
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ESP-01

- Pinout

O
0
a
|
[m]
=]
—

[

O OcGPIO2
rsT|O OcPio0

vee|O ORX

™[O Q6N

CH_PD

ESP-01

REAL . .
@1.1. | rolet.io

ESP-01

- GPIO

o~ O
o 90
Z o o X
0,0.0.0x
0:0 00
afele]e
X 0O = O
“EE 8
o

ESP-01

REAL . -
©17. | rolet.io
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ESP-01

- How to program/flashing that chip.

RX <- TX

3.3V FTDI USB/UART

GPIOO

REAL . =
@1.1. | rolet.io

ESP-01

- Breakout Board

REAL . e
©17. | rolet.io
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- Pinout

RST 1.0 [©C22 TXDO
ADC 22 0] [©C21 RXDO
EN 320 [©C20 GPIOS

GPIO16 420l | Eop 42.E Series || 12§19 GPIO4
GPIO14 5.0 [©C18 GPIOD
GPIO12 6.20) [©C17 GPIO2
GPIO13 7.0 [©C¢16 GPIO15

vcc 8.0 [©¢15 GND

[~] [~

9 10 11 12 13 14

0 = 2 2 = O

23 % %8¢

S po ==
QB
o

REAL . .
@1.1. | rolet.io

- GPIO

§ S0y ESP-12-E Series
! GPIO14 :

i GPIO12:
P GPIO13 :

-
o
e
-
e
el
-
w
=
-

0SD © )]
OSIN
60IdO«
ISOW
A0S

REAL . -
©17. | rolet.io

e®D_
mdy
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ESP-12

- Breakout Board

EspressoLite NodeMCU WeMos

(ESP-WROOM-02)

REAL . =
@1.1. | rolet.io

Programing Platform

AT #include <Servo.h>
Servo myServo; Password!:
ol //MultiWii is equipvalen to Arduino Pro Mini WebREPL connected
K //Pairoch J. Bl 443
AT+ g void setup() { i3 . - -
AT version:0.49.0.0(Aug 8 2015 14:45:58) 5 ttach(9): >>> print("Bello uPython")
SDK version:1.3.0 myServo.attach(9); Hello uPython
: i myServo.write(@); >»> import machine
mTThlnker Technology Co.,Ltd. delay(3000): 55> machine.freq()
Build:1.3.0.2 Sep 11 2015 11:48:04 myServo.write(70); 80000000
ok ) >>> machine.freq(160000000)
AT-+CWMODE ? >>> machine.freq()
160000000
+CWMODE : 3 void loop() { >>> |

AT command Arduino (C) MicroPython

©.0,

REAL . .
©17. | rolet.io

e®D_
mdy
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Work Shop!

Set Environment

ARDUINO
¢ Download then Install ArduinolDE (www.arduino.cc)

o Start Arduino and open Preferences window.
* Enter http:/arduino.esp8266.com/stable/
package_esp8266com_index.json into Additional

Board Manager URLs field.

* Open Board Manager from Tools > Board > Board
Manager and then install esp8266 by ESP8266
Community

REAL . .
©17. | rolet.io
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Set Environment

¢ Install dependency libraries St
* Open Library Manager (menu Sketch > Include
Library > Manage Libraries...) then install
libraries you want.

DHT sensor library by Adafruit

Adafruit GFX Library by Adafruit

ESP8266 Oled Driver for SSD1306 display by Daniel Eichborn
HttpClient by Adrian McEwen

PubSubClient by Nick O'Leary

REAL . .
@1.1. | rolet.io

Set Environment

¢ USB-Serial communication

i y L, @8 4, 1 , @8 ; 1, 8, 1, 0, |
+13U 1
1
I
i
i
i
1
ldle 1dle ~—— RS-232

i ™~
i
I
1
i
i
e i Start | LSB [ | 1 i | | SB ; Stop
1 Bit I [ | i I i | 1 Bit |

Sending 0b01010101
| T ER TR NETE SET N i
SU .
1dle l1ge ~_~— TTL/UART

I
I
e 1 Start | LSB I ] I i | | HSB S‘PP:
1 Bit I [ 1 I I i 1 1 Bit

Most microcontrollers these days have built in UARTSs (universally asynchronous receiver/transmitter) that can be used to
receive and transmit data serially. UARTs transmit one bit at a time at a specified data rate (i.e. 9600bps, 115200bps, etc.).
This method of serial communication is sometimes referred to as TTL serial (fransistor-transistor logic). Serial communication
at a TTL level will always remain between the limits of OV and Vce, which is often 5V or 3.3V.

The RS-232 standard a logic high ('1') is represented by a negative voltage from -3 to -25V, while a logic low ('0') transmits a
positive voltage that can be anywhere from +3 to +25V. On most PCs these signals swing from -13 to +13V.

REAL Source: sparkfun.com
@rr. | roiet.io

e®D_
mdy
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Set Environment

o USB-TTL chip (ie. FTDI, CH340, CP2102)

REAL . "
@1.1. | rolet.io

Set Environment

o Install driver for USB-TTL chip

Mac / Linux;

Download: http://www.realitlimited.com/training/
msu/2017-02-17/10T101/CH340 Mac.zip

ls -ltr /dev/cux
4 05:05 /dev/cu.PAIROCH-MACAIR-Bluetoot
4 05:05 /dev/cu.Bluetooth-Incoming-Port

16 12:41 /dev/cu.wchusbseriall420
16 12:42 /dev/cu.wchusbseriall410

REAL . -
©17. | rolet.io
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Set Environment

¢ Install driver for USB-TTL chip

Windows:

Download: http://www.realitlimited.com/training/
msu/2017-02-17/10T101/CH34x_Windows.zip
or http://www.wch.cn/download/CH341SER EXE.html

- &¥ Network adapters
=5 Ports (COM &LPT)

. Y% Communications Port (COM1)
. Y3 Communications Port (COM2)
. Y3 printer Port (LPT1)

| L.Y3¥ USB-SERIAL CH340 (COM3)
n Processors

REAL . .
@1.1. | rolet.io

Flashing Firmware

1. Download Firmware (.bin)

www.realitlimited.com/training/msu/2017-02-17/

loT101/Firmware.zip

Name ~ Size
F MicroPython-espB8266-20160909-v1.8.4.bin 563 KB
I Official-v1.3.0.2_AT_Firmware.bin 1MB

REAL . -
©17. | rolet.io
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Flashing Firmware

2. Download Flasher

2.1 Mac / Linux:
#pull the source code from git repository
$git clone https://github.com/themadinventor/
esptool.git
$cd esptool
$sudo python setup.py install

2.2 Windows:
www.realitlimited.com/training/msu/2017-02-17/
loT101/Flasher.zip
or https://github.com/nodemcu/nodemcu-flasher

REAL . .
@1.1. | rolet.io

Flashing Firmware

3. Upload Firmware into Chip

3.1 Mac / Linux:
esptool.py -b [baud-rate] -p [device] write_flash [address] [firmware-file-name]
Example:
esptool.py -p /dev/ttyUSBO erase_flash
esptool.py -b 115200 -p /dev/ttyUSBO write_flash 0x00000 Official-

v1.3.0.2_AT_Firmware.bin

esptool.py vl.2-dev
Connecting...

Running Cesanta flasher stub...
WARNING: Unlikely to work as data goes beyond end of flash. Hint: Use —flash_size

Flash params set to 0x0000

Writing 1044480 @ 0x0... 1044480 (100 %)

Wrote 1044480 bytes at 0x® in 90.2 seconds (92.6 kbit/s)...
Leaving...

REAL . N
©17. | rolet.io
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3.2 Windows:

o .e Al L]

Operation Config nced About Log eration Config A nced Abo Operation Confi
g 9 F

mcu-flasher-master\WBISIZAT Fiffwarebin - 75 X00000
| Port CONES ash(F) INTERNAL://IROM 78" OX10000
INTERNAL://DEFAULT & FREnn
INTERNAL://BLANK 78" (X7E000

\C Waiting MAC AP MAC 1A-FE-34-
\C Waiting MAC ac 18-Fe-34-

Port COM13 Stop(S)

REAL . B
@1.1. | rolet.io

Open Arduino IDE. Select Board & Port

Auto Format 8T Auto Format 8T
Archive Sketch Archive Sketch
Fix Encoding & Reload Fix Encoding & Reload
Serial Monitor O ®BM Serial Monitor %M
Serial Plotter 8L Serial Plotter 038L
Board: “WeMos D1 R2 & mini" >
CPU Frequency: "80 MHz" > CPU Frequency: "80 MHz" >
Flash Size: "4M (3M SPIFFS)" > Flash Size: "4M (3M SPIFFS)" >
Upload Speed: "921600" > Upload Speed: "921600" >
Port: "/dev/cu.wchusbserial1420" 2
Programmer: "AVR ISP" > Programmer: "AVR ISP" »
Burn Bootloader Burn Bootloader

REAL . -
@LT. | roiet.io
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REAL " .
@1.1. | rolet.io

REAL . -
©17. | rolet.io

First Test

- Select Baud Rate (Upload Speed): 115200

[Toos 3

Upload Speed: "115200"

Auto Format 8T
Archive Sketch

Fix Encoding & Reload

Serial Monitor T 8M
Serial Plotter 8L

Board: "WeMos D1 R2 & mini" >

CPU Frequency: "80 MHz"
Flash Size: "4M (3M SPIFFS)"

\ Ay v

Port: "/dev/cu.wchusbserial1420"

v\ v

Programmer: "AVR ISP"
Burn Bootloader

Talking with Chip

- Serial Monitor

e®D_

20

Helo
Auto Format ®T om 16
Archive Sketch tail 4
Fix Encoding & Reload chksum @x89
toakt
Serial Plotter L 0K
. AT+GMR
Board: "WeMos D1 R2 & mini" > AT version:0.40.0.@(Aug 8 2015 14:45:58)
CPU Frequency: "80 MHz" > SDK version:1.3.0
Flash Size: "4M (3M SPIFFS)" > AltTthker Technology Co.,Ltd.
Build:1.3.0.2 Sep 11 2015 11:48:04
Upload Speed: "115200" - oy »
Port: "/dev/cuwchusbserial1420" >
Programmer: "AVR ISP" >
Burn Bootloader Autoscroll Both NL & CR

anANgNT 614181009] Page 25|43



Talking with Chip

- AT Command

AT
AT+GMR (version firmware) on 16
tail 4
chksum @x89
AT+CWMODE? (Check mode) LoaAT
1=Client oK
2=SerVer(AP) :?ﬁswn'a 49.0.0CAug 8 2015 14:45:58)
3=AP+Client SOK version:1.3.0 o
Ai-Thinker Technology Co.,Ltd.
Build:1.3.0.2 Sep 11 2015 11:48:04
AT+CWMODE=1 0K

AT+CWLAP (list the Access Point nearly)
Autoscroll Both NL & CR

AT+CWJAP=“#8 AP”,”551] password”

AT+CIFSR (list the obtained IP & Mac address)

REAL . .
@1.1. | rolet.io
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3. Device and Software

3.1 yaRnn1siseus auanailefiauazlaledt (1oT Learning 101 )

loT Learning 107

A

REAL I i Ehailan!

U G D04 U:il 0.2 Dl RX TX
RGEBEREN
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aunsaINRANSaUUINULBSA

Wemos (Wemos is an ESP8266-12 based WiFi enabled
microprocessor): Vuthitaueina fisiausadeulusunsy

d19ule aunsnnemdasula

Potentiometer: f@unuUsuAle 151a1315a U
Tsunsuarumasululonyuunuy weidutoululunis

MIUVDITEUUNILST19DALUU

LED: nasalw wiialduuenaaiugaisgaiutouluiisideu

TUsunsa

Push button: Yuadng 151810135008 ulUsuNsu81uAINI5NA
wsaUaawading atdutaulvlunisvitauvesssuuniegm

9NLUU

Buzzer: a1lnwsau1atan liedadss aua1udnsinivuale

OLED Screen: 990 MAUIALAN LNDLAAINAAISAINTILTT

WeulUShNTUE

USB Data Cable: @1gtaya Litounauiamasivuesa Lile

Weulusnsy wazdsanunsarduasunassnglwliduuasals

[dilevndngns 614181009] Page 28|43
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< -
LYULYDINTY

o

874714 (Resistor)

L%uLﬂJai‘i’ﬂqmwQﬁ%admm (DS18B20 One Wire Waterproof Temperature Sensor)

waslundeuln 180 83 (Servo 9e)

[gilevndngns 614181009] Page 29|43



WwuesInANNTUlLAY (Soil moisture sensor)

UDIANAADY MB995AULUU (Breadboard)

Pauhwuiadn (DC Micro Submersible Water Pump)

[gilevdngns 614181009] Page 30|43



COLLECTOR BD 139

BASE

EMITTER

N51UTAMDS (Transistor DB139)

anglvluargunsaliingqiiion1smaaes Jumper Cable)

[gilevndngns 614181009] Page 31|43



3.2 Arduino faazls

ARDUINO
OPEN-SOURCE
COMMUNITY

Arduino {Wumn1w1dna musuniiavendndsdl azeendedin 019l 3e 819l wuy

Inualiwilaugasu anunsarumaesndedluiald windedneeanides 019l AUy

Arduino Aa&UFILATU...Micro controller + Development Board + Programming

Platform Yav818A27un9lASU

1. Micro controller: Uu Chip Ussananavuinian (Microchip) tsnanunsaidaulusunsuls
FurhnumuIsdeInsieasulaesuldsunsuneauiimes wainraulngd antuisnlvan

Heasluludn 151 Microchip @ aelwlviiuudidunasvaunuislusunsy

o'r%t.l(ﬁ!

3U Microcontroller

2. Development Board: n15#ay enlnaalusunsuileaslulusi Microcontroller latiu Tu
adunousssiigunsalilvg wasdudounnasu asmanldnudiuilizeddvy waunwnldey

Tsunsunldnren Assembly dugaenn Badfinmuaiuinlinsimunauun

[gilevndngns 614181009] Page 32|43



wadaglu nnegrafdredu fiflesans USB daudiuesa Arduino Aanunsaideuluswnsuily
adlu Microcontroller lawarnsu dunuillideulusunsuiamnsaldniuiily egraniw
C/C++ wenaNTU Favesna Arduino Seeanuuulsianunsaweuseiugunialaninniivise

wuasaulaasan lgsen

o oo o o o o |

el L —————
‘)) % ~ POWER
43 ® y ™
b T €

U Arduino Board 3u UNO t51ihlulnsaaulatass yu ATMega 328P 15eulavias tiiesnivanlusunsu

Ua$n Arduino 51A19nATU nanSesies wazdalivainanesulideniiwunediulusida viiei
LTI RTNATAYIIUDTAFEULUY Arduino Lel INT12UBSAYNEBNLUUNTLUULUALKE

%9alAng15ALT (Open Source Hardware)

Arduino senuuuildivlulasreulvaaesvasuisn ATmel u ATMega..xox Fadu
lulasmeulnaaesildnude iaunsademisdilasraulvamesinldiuueiniuvisousin
Msrasredeutuuiunlandu Jasailulasroulnaaes WAMANAUUIY WAUBIAUNTUALAN

wnFaveululasreulvamesiniuuesaay AuFUAUA1N
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FUUNYIABUETA Arduino §u Nano Uaz Pro Mini

3. Programming Platform

http://www.arduino.cc

HOME BUY SOFTWARE PRODUCTS Eou RESOURCES COMMUNITY HEL®

Download the Arduino IDE

ARDUINO 1.8.5

% ] i Mac OF X 107 Lon or newer

L 52
Linux
Limux Afikd

HOURLY BUILDS -mﬁ;ﬂ:am

nad & e g of tha incorning reliase th the most
uceted features and bugfoes

e®D_
mdy
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3.3 AnAaluswnsd ARDUINO IDE d1ususteuldswnsy

n158nAlUsUNIY Arduino IDE uazuasa Driver UussuuUfuiAn1s Windows

Arduino IDE «Jugeviwisfilddmsu Upload TUsunsudsnumiaainnd(Sketchi@adeude
LUsunsunw C v3e C++ Widuesalulasreulnsaaead 817 wWu Arduino Uno, Arduino
Nano, Arduino Pro Mini, Arduino Mega waglulasaaulnsawesiunsena Arduino w9 B9
vainesneluansndeudelufusumesuszinndney wenand Arduino IDE Ssansnsald
Iumié’ulwamT,UiLLﬂsulﬂé’aiuTﬂiﬂauImaLaaﬂum5zga§uq a7l iU ESP8266 iy Wi
chip l68nde Tunsindeuarimunrisuduliiulusunsy Arduino IDE $5easdentunon
Feseluil

1. ¥ Google wdAunlagldAdiasn arduino ide download Wiawlu

896 https://www.arduino.cc/en/Main/Software [@ouadsinuaLantioy azUs1Ng900 WA

vy &
JUTNANU
w HOME BUY SOFTWARE PRODUCTS EDU RESOURCES COMMUNITY HELP Q @ siGNInN
Download the Arduino IDE
ARDUINO 1.8.5 Windows app Requ
Th n-source Arduing Soft Get 28
Mac OS X107 Lion or newer
Linux 32 bits
Linux 64 bits
Linux ARM
Rel =
Source Code
Checksums (shaS12)
HOURLY BUILDS BETA BUILDS
Download  preview of the incoming release with the maost Daownload the Beta Version of the Arduino IDE with
updated features and bugfixes experimental features. This version should NOT be used in
production
;M ,:,5), ac s lsan g later) I:A«. OX (Mac 05X Mourtain Lion or later)
5 Linux 32 bit, Linux 64 bit, Linux Arm
6 QIJ 1 6 = a 6 . .
2. amulvaanestudgaluvlesuun Ineidanisd Windows Installer, for Windows XP
and up

3. Wausngasnimdneansil idenyu Just Download LitaisusunlanYiuy viseiden
Uu Contribute & Download Lau3anRuatuayumanules widwmniuluan

TUsunsy Arduino IDE Gaidulawmumesavesives Tuidl idends Just Download
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https://www.arduino.cc/en/Main/Software

Q @ SIGNIN

ARDUINO HOME BUY SOFTWARE PRODUCTS EDUCATION RESOURCES COMMUNITY HELP

Contribute to the Arduino Software

Co

de g the Arduino Software by contributing to its development. (US tax payers, please note this contribution

SINCE MARCH

THE ARDUTNO TDE HAS BEEN DOWNLOADED

TVE!) NO LONGER JUST FOR ARDUTNO AND
GENUINO BOARDS, HUNDREDS OMPANTES AROUND THE WORLD ARE
USING THE IDE TO PROGRAM THEIR DEVICES, INCLUDING COMPATIBLES
CLONES, AND EVEN COUNTERFEITS. HELP ACCELERATE ITS DEVELOPMENT
WITH A SMALL CONTRIBUTION! REMEMBER: OPEN SOURCE IS LOVE!

$3 S5 $10 $25 S50 OTHER

JUST DOWNLOAD CONTRIBUTE & DOWNLOAD

4. fanaiadanan irumuazdulandnuulid arduino.exe Bondnglusunsy asusing

F0AMAIFUT9E4

& sketch_jun27a | Arduino 1.8.5 — O X

File Edit Sketch Tools Help

sketch_jun27a

void setup() { ~
// put your setup code here, to run once:
}
void loop() {
// put your main code here, to run repeatedly:
}
v

oA
(g
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5. AaAsEAY Wieadlranlausns ESP8266 lneldrds File=>Preferences Liausing

lnazann Preferences lvidnasntoauad

‘f‘j http://arduino.esp8266.com/stable/package esp8266com index.json 1

13 (Ctrl+V) Tusies Additional Boards Manager URLs: sfagudnaanail udandntu OK Lile

@
9NN lnevaan

Preferences

Settings  Network

Sketchbook location:

C:\Users\I AM\Documents\Arduino

Editor language: System Default
Editor font size: 12
Interface scale: Automatic 100 5 (%

Show verbose output during: [_| compilation [_] upload

Compiler warnings: None

[_] pisplay line numbers

[ Enable Code Folding

Verify code after upload

[ ] Use external editor

Aggressively cache compiled core
Check for updates on startup

Browse

~ | (requires restart of Arduino)

(requires restart of Arduino)

Update sketch files to new extension on save (.pde -> .ino)

Save when verifying or uploading

Additional Boards Manager URLs: )| http://arduino.esp8266.com/versions/2.4.1/package_esp8266com_index.jsor]|

More preferences can be edited directly in the file
C:\Users\I AM\AppData\Local\Arduinol5\preferences. txt

(edit only when Arduino is not running)

oK Cancel

6. \ilofiazanilnan ESP8266 Uosauarlausd Wilufluy Tools =>Board:

“Arduino/Genuino Uno” =>Board Manager $1a3u?19a14il

[

?
Y

a
U

avnangmns 6141810009
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E® sketch_jun27a | Arduino 1.8.5
File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_jun27z Fix Encoding & Reload
void setup() Serial Monitor Ctrl+Shift+M
// put you Serial Plotter Ctrl+Shift+L
) WIiFi101 Firmware Updater
Board: "WeMos D1 R2 & mini” I b &
void loop () Flash Size: "4M (1M SPIFFS)" BTN R
// put you Debug port: "Disabled” Arduino AVR Boards
) Debug Level: "None" Ardu?no Yun _
IwlP Variant: "v2 Lower Memory" Arduino/Genuino Uno
CPU Frequency: "80 MHz" Arduino Duemilanove or Diecimila
Upload Speed: "921600" Arduino Nano
Erase Flash: "Only Sketch” Arduino/Genuino Mega or Mega 256
Port "COM3" Arduino Mega ADK
Get Board Info Arduino Leonardo
Arduino Leonardo ETH
Programmer: "AVRISP mklI* Arduino/Genuino Micro
Burn Bootloader Arduino Esplora

7. azusngresdum Tiafindd1in esp8266 Liteduvn wifi chip fail wén
den Contributed 71U esp8266 by ESP8266 Community Aaguiua1e Ingiaauiladn

Wouse Bumasiun waI3enanUy Install

& Boards Manager X

esp82e6

Type |All ™|

esp8266 by ESP3266 Community

Generic ESP8266 Module, Generic ESP8285 Module, ESPDuino (ESP-13 Module), Adafruit Feather HUZZAH ESP8266, ESPresso Lite 1.0, ESPresso
Lite 2.0, Phoenix 1.0, Phoenix 2.0, NodeMCU 0.9 (ESP-12 Module), NodeMCU 1.0 (ESP-12E Module), Olimex MOD-WIFI-ESP8266(-DEV), SparkFun
ESP&266 Thing, SparkFun ESP8266 Thing Dev, SweetPea ESP-210, WeMos D1 R2 & mini, WeMos D1 mini Pro, WeMos D1 mini Lite, WeMos D1 R1,
ESPino (ESP-12 Module), ThaiEasyElec's ESPino, Wifinfo, Arduino, 4D Systems gend IoD Range, Digistump Oak.
Online help

Mare info

Al

<

Install

Close

e®D_
mdy
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8. ilod5a azdunisindsli Arduino IDE s9niululastu ESP8266 NnuuisanunsaLden

yasanazldau luniagltuasninae Wemos D1 mini

(o]
File Edit Sketch Tools| Help

Auto Format Ctrl+T
Archive Sketch
sketeh_jun123 Fix Encoding & Reload
vold setup() Serial Monitor Ctrl+Shift+ M
// DUt YOUD ool Plotter Ctrl+ Shift+L
} WiFi101 Firmware Updater
veld leop() { | Board: "Arduino/Genuino Uno" A
J{ put your Port: "COMT" Arduine Pro or Pro Mini
} Get Board Info Arduino NG or older
Arduine Robot Control
Programmer: "AVRISP mkll" Arduine Robot Motor
Burn Bootloader Arduine Gemma

Adafruit Circuit Playground
Arduine Yan Mini

Arduine Industrial 101

Linino One

Arduing Uno WiFi

ESPE266 Modules

Generic ESP2266 Module
Generic E5P2285 Module
ESPDuino (ESP-13 Module)
Adafruit Feather HUZZAH ESPE266
ESPresseo Lite 1.0

ESPresso Lite 2.0

Phoenix 1.0

Phoenix 2.0

MNodeMCU 0.9 (ESP-12 Module)
ModeMCU 1.0 (ESP-12E Module)
Olimex MOD-WIFI-ESP3266(-DEV)
SparkFun ESP8266 Thing
SparkFun E5P2266 Thing Dev
SweetPea ESP-210

WeMos D1 R2 & mini

WeMaos D7 mini Pro

WeMos D1 mini Lite

WeMos D1 R1

(S A &

104800 Port Adlunsideure Wemos lufitidanidu COM3

=1 ' o Y ' = a P
**% Port LVULAVLLANAIAU LA ALLAIDIADUNILNDT

e®D_
=3
®
=~
De
o}

e
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€9 sketch_jun27a | Arduino 1.8.5
File Edit Sketch Tools Help

sketch_jun27z

void setup ()
// put you

void loop()
// put you

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

WIiFi101 Firmware Updater

Board: "WeMos D1 R2 & mini”
Flash Size: "4M (1M SPIFFS)"
Debug port: "Disabled”
Debug Level: "None”

IwlP Variant: "v2 Lower Memory™

CPU Freguency: "80 MHz"
Upload Speed: "921600"
Lrase Flash: “Onlv Sketch*

Ctrl+T

Ctrl+Shift+M
Ctrl+Shift+L

Port: "COM3"
Get Board Info

Programmer: "AVRISP mkll*
Burn Bootloader

n15Rame CH340 Driver 1w USB driver

1. Download driver i pAnA54i (http://iot-training-

Serial ports

v coms

playground.com/download//Software-and-Lab-Code/USB-
TTL/CH34x_Windows.zip)

2. yhmsuanlndaglaluadsgy

Mame

ﬁ CH3dx_Install_Windows_v3_4.EXE

3. yinsnsalagnsiudy Install

Date modified

24/1/2560 77

20

8uan

Type Size

Application

q

ms 614181009]

238 KB
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http://iot-training-playground.com/download/Software-and-Lab-Code/USB-TTL/CH34x_Windows.zip

Device Driver Install / UnlInstall

Select IHF CH3IM1SER.INF

WCH.CH
| __ USB-SERIAL CH34B@
| ___ 88788726014, 3.4.2081Y

INSTALL

UHIHSTALL

HELP

A4 a < 1% & o a v
4. \ilefnAaasaudrastuneguanunsalalaiay
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4 DIGITAL & ANALOG

Digital I | I | I | I I
Analog /\/\/.\/\
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5 LAB LESSON

http://iotobectraining.com/lms/index.php/lab-code/
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